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This User Guide is been implemented by Boot & Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience
This User Guide is intended for the following audience:

e Persons in charge of introducing automation devices.
e Persons who design automation systems.

e Persons who install or connect automation devices.

e Persons who manage working automation installation.

e Unused pins should not be connected. Ignoring the directive may damage the
controller.

e Improper use of this product may severely damage the controller.

e Refer to the controller’s User Guide regarding wiring considerations.

e Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

e Maintenance must be performed by qualified personnel familiarized with the
construction, operation, and hazards involved with the control.

e Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

e Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

e The Ardbox Family PLCs are Open Type Controllers. It is required that you install the
Ardbox PLC in a housing, cabinet, or electric control room. Entry to the housing,
cabinet, or electric control room should be limited to authorized personnel. Failure to
follow these installation requirements could result in severe personal injury and/or
property damage. Always follow these requirements when Ardbox family PLCs.



e In case of installation or maintenance of the Ardbox please follow the instructions
marked in the Installation and Maintenance section.

e Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements:

e Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le controleur.

e Une utilisation incorrecte de ce produit peut endommager gravement le contréleur.

e Reportez-vous au Guide de I'utilisateur du contréleur pour les considérations de
cablage.

e Avant d'utiliser ce produit, il incombe a I'utilisateur de lire le Guide de l'utilisateur du
produit et la documentation qui I'accompagne.

e La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au contréleur.

e La maintenance doit étre effectuée avec I'équipement hors service et déconnectée de
toutes les sources d'alimentation.

e Faites attention lors de I'entretien des composants sensibles a |'électricité statique.
Les recommandations du fabricant pour ces composants doivent étre suivies.

e Les automates de la famille Ardbox sont des controleurs de type ouvert. Il est
nécessaire d'installer I'automate Ardbox dans un boitier, une armoire ou une salle de
controdle électrique. L'accés au boitier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de l'installation des automates de la
famille Ardbox.

e En cas d'installation ou de maintenance du Ardbox, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

e Ne débranchez pas I'équipement en présence d'une atmosphére inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmospheére
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.

Application Considerations and Warranty



Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESSIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

¢ Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

e Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.

Intended use or of Industrial Shields products



Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in
the catalogue and the associated technical documentation. If third-party products and
components are used, they must have been recommended or approved by Industrial
Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct It
must respect the permissible ambient conditions. You should also follow the indications
and warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or
manipulated by qualified personnel for the task entrusted and observing what is
indicated in the documentation corresponding to it, particularly the safety instructions
and warnings included in it. Due to their training and experience, qualified personnel
are in a position to recognize risks resulting from the handling or manipulation of such
products / systems and to avoid possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.

Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons.

It is our practice to change model numbers when features are changed, or published
ratings or when significant construction changes are made. However, some
specifications of the products may be changed without any notice. When in doubt,
special numbers may be assigned to fix or stablish key specifications for your
application on your request. Please consult with your INDUSTRIAL SHIELDS
representative at any time to confirm actual specifications of purchased products.

Errors and Omissions



The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.

The control and drive components of an Industrial Shields PLC are approved for
industrial and commercial use in industrial line supplies. Their use in public line
supplies requires a different configuration and/or additional measures. These
components may only be operated in closed housings or in higher-level control
cabinets with protective covers that are closed, and when all of the protective devices
are used. These components may only be handled by qualified and trained technical
personnel who are knowledgeable and observe all of the safety information and
instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU
Machinery Directive, the machine manufacturer must consider the following residual
risks associated with the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning,
operation, maintenance, and repairs caused by, for example: — Hardware defects
and/or software errors in the sensors, controllers, actuators, and connection technology
- Response times of the controller and drive — Operating and/or ambient conditions not
within the scope of the specification — Condensation / conductive contamination -
Parameterization, programming, cabling, and installation errors — Use of radio devices /
cellular phones in the immediate vicinity of the controller — External influences /
damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by,
for example: - Component malfunctions — Software errors — Operating and/or
ambient conditions not within the scope of the specification — External
influences / damage.

3. Hazardous shock voltages caused by, for example: — Component malfunctions -
Influence of electrostatic charging — Induction of voltages in moving motors — Operating
and/or ambient conditions not within the scope of the specification - Condensation /
conductive contamination — External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose
a risk to people with a pacemaker, implants or metal replacement joints, etc. if they are
too close.

5. Release of environmental pollutants or emissions as a result of improper operation
of the system and/or failure to dispose of components safely and correctly.

Warranty and Limitations of Liability



Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-
INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS.
ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE
REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR
REPAIR.
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Supply Yoltage

24 \ce

I/Os

Digital
Analog

GPRS Ardbox Relay HF: General Features

RELAY

COMPACT PLC ARDUINO ARDBOX 201/0s

HF

Fuse protection (2.5A)

Input Voltage 12 to 24vdc Polarity protection
Input rated voltage 24 Vde
Rated Power 30W
| Max. 1,5A
Size 100x45x115
Clock Speed 16MHz
32KB of which 4KB are used by
Flash Memory bootloader
SRAM 2.5KB
EEPROM 1KB

I12C -- USB -- RS232 -- RS485 --

Analog Output 8bit
(0-10Vcce)

Communications SPI -- TTL — GPRS RS485
TOTAL Input points 10
TOTAL Output points 10
0 to 10Vac
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vac
An/Dig Input 10bit
(0-10Vcce) 7 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24 Vdc
* Interrupt isolated Input iy 28 7 to 24vdc
I min: 2to 12 mA I min: 3/6 mA
HS Galvanic Isolation Se arated PCB around
(24Vce) Rated Voltage: 24Vdc p 9
0 to 10Vac
I max: 20 mA

Separated PCB ground
Rated Voltage: 10Vac

Digital Isolated Output
(24Vce)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Imax 24Vdc: 410 mA

PWM Isolated Output
8bit (24Vcc)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

PWM Isolated
Output 8bit (24vcce)

Expandability

12C — RS232 — RS485 — SPI - TTL
- GPRS

Reference

006001001300




2. Technical Specifications

2.1

General Specifications:

Power supply
voltage

DC power supply 12 to 24Vdc ==

Operating
voltage range

DC power supply 11.4t0 25.4Vdc ===

Power
consumption DC power supply 30VAC max.
External Power supply voltage | 24vdc ===
power supply
Power supply output 200 MA

Insulation resistance

capacity

20MQ min. at 500Vdc between the AC terminals and the protective ground
terminal.

Dielectric strength

2.300 VAC at 50/ 60 Hz for one minute with a leakage current of 10mA
max. Between all the external AC terminals and the protective earth
terminal.

Shock resistance

80m/s? in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0° to 60°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage) -20° to 60°C
Power supply holding time 2ms min.
350g max.

Weight

2.2 Performance Specification:

Arduino Board

ARDUINO LEONARDO

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform
composed of a programming language. “similar to the C”.
http://arduino.cc/en/Tutorial/lHomePage

Microcontroller

ATmega32u4

Flash Memory

32KB of which 4KB are used by bootloader

Program capacity (SRAM)

2.5KB

EEPROM

1KB



http://arduino.cc/en/Tutorial/HomePage

Clock Speed

16MHz

2.3 Symbology

Svmbol Standard No./ Standard
y Standard Title Reference No. / Symbol Meaning
Symbol Title
IEC 60417 / . . .
E— ; . Indicates that the equipment is
B EE = Graphical symbols 5031 / Direct suitable for direct current only;
for use on Current . . ;
. to identify relevant terminals
equipment
IEC 60417 / Indicates that the equipment is
Graphical symbols . suitable for alternating current
N for use on 5032(/:Alternat|ng only; to identify relevant
. urrent .
equipment terminals
IEC 60417 /

Graphical symbols 5130 / Pulse To .|dent|fy the _control by
for use on General which a pulse is started.
equipment
IEC 60417 / To identify an earth (ground)

Graphical symbols terminal in cases where
for use on 5017/ Earth, neither the symbol 5018 nor

. Ground : . :
equipment 5019 is explicily required.
IEC 60417 / . : .
Graphical symbols To identify the swﬂch by
means of which the signal
for use on 5115/ Slgnal lamp ) )
) lamp(s) is (are) switched on or
equipment off

Medical Devices

CE marking indicates that a
product complies with

Directive CE Marking applicable European Union
93/42/EEC PP P
regulations
ISO 7000/ : .
Graphical symbols Indlcates.a p(.)tentlal'ly '
f 0434B / hazardous situation which, if
or use on . . .
. Warning symbol not avoided, could result in
equipment : L
death or serious injury
ISO 7000/
Grap;hlcal symbols 5036 / Dangerous To indicate hazards arising
or use on
. Voltage from dangerous voltages
equipment




3. Precautions

Read this manual before attempting to use the ARDBOX 20 I/Os Relay HF GPRS and follow its
descriptions for reference during operation.

3.1 Arduino Board

The ARDBOX 20 I/Os Relay HF GPRS PLCs include Arduino Leonardo Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate Ardbox according to the performance specifications described in this
manual.

Before using ARDBOX 20 I/Os Relay HF GPRS under different conditions from what has been
specified in this manual or integrating ARDBOX 20 I/Os Relay HF GPRS to nuclear control
systems, railroad systems, aviation systems, vehicles, combustion systems, medical
equipment, amusement machines, safety equipment and other systems, machines, and
equipment that may have a serious influence on lives and property if used improperly, consult
your INDUSTRIAL SHIELDS representative. Ensure that the rating and performance
characteristics of Ardbox are sufficient for the systems, machines, and equipment, and be sure
to provide the systems, machines, and equipment double safety mechanisms. This manual
provides information for programming and operating the Ardbox.

4. Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed using directly C but it is much easier working with
Arduino IDE as it provides lots of libraries that helps in the programming.

Furthermore Industrial Shields provides boards for programming the PLCs much easier.
Basically it is no needed to define the pins and if that pins are inputs or outputs. Everything is
set up automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.
Requirements:

Arduino IDE 1.8.0 or above (better to have always the latest version).



Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences X

Settings  Metworl:

Sketchbook: location:

C:\Users\Albert\Documents'\Arduing Browse
Editor language: English (English) ~ | (requires restart of Arduino)

Editor font size: 15

Interface scale: Automatic | 100 5 %  (requires restart of Arduino)

Show verbose output during:

Compiler warnings:
[CIbisplay line numbers
[C]Enable Code Folding

[ Verify code after upload
[Juse external editor
Check: for updates on startup

Update sketch files to new extension on save (pde -> .ino)

Save when verifying or uploading

Additional Boards Manager URLs:  http:/fapps.industrialshields.com/main/arduinoboards package_industrialshields_inde: [

Mor fe di ly in the file

re e
C:\Users\Albert\AppData\Local\Arduino 15\preferences. bt

Ok Cancel

2. In Additional Boards URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields index.json

3. Press OK to save the changes.

4. Go to: Tools -> Board: ... -> Boards Manager

@ sketch_mari6a | Arduin 180
File Edit Sketch Tools Help

Auto Format Cul+T
Achive Sketch
Fix Encoding & Reload

Serial Monitor Ctrl4ShiftsM
Sertal Plotter Cul+Shittsl

WFi101 Finmware Updater

Board: “M-Duino lamily” + Boards Manager...
Indusirial Shvells: "M-Duino 58+ 3 uino AVR Boards
" pon Arduine Yin
"t Get Board Info Asduino/Gensino Una
Programmer: “Archiino as ISP i Arduino Duemilanove or Diecimila

Ardhuino Nano

Bum Bootioader

Archino/Genuano Mega of Mega 2560
Arduin Mega ADK

Arduing Leonardo

Arduina Leonardo ETH
Arduino/Genuine Micro

Arduino Esplora

Arduino Mini

Arduina Ethernet

Arcuina Fio

Arduino BT

LilyPad Archuino USB

LilyPad Arduino

Arduine Pro of Pro Min

Arduino NG or older

Arduing Robot Control

Arduino Robat Motor

Arduina Gemma

Adatruit Circuit Playgrotind
Arduing Yun Mini
Arduing Incusgrial 101
Linino One
Arduine Uno WiFi

Indusinal Shields boare
Asdbox family
# M-Duino family


http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json

5. Search for industrialshields.

& Boards Manager %
Type All ~ | |industrialshields
industrialshields &

Boards included in this package:
ARDBOX family, M-Duino family.

Online help
More info

~ || Install

Close
6. Click install (selecting the latest version).
Following this steps you will be able to use now the Industrial Shields Boards:

File Sketch Tools Help

Auto Format et
Archive Sketch
skelch_aug25  Fix Encoding & Reload

(| Manage Libraries. Cri+Shiftel ~
Serial Monitor Cur+ShiftsM
Serial Plotter Crri+ShifteL

WIFi101 / WIFININA Firmware Updater

() Board:“Ardbox WIFI/BT family" 3 Boards Manager.
| Model:"Ardbox Analog HF+ w/ HW RS-232 WIFi/BT* =
y n M5S5tack-FIRE

Get Board Info M5Stick-C
ODROID ESP32

Programmer. *Arduino Gemma" )
Bum Boatioader

Heltec WiFi Kit 32
Heitec Wifi LoRa 32
Heltec Wifi LoRa 32(2)
Heltec Wireless Stick
ESPectro32
Microduino-Core€sp32
ALKS ESP32

WiPy 30

BPI-BIT

Silicognition WESF32
T-Beam

D-duino-32

LoPy

Lopy4

OROCA EduBot

ESP32 FM DevKit

Frog Board ESP32

Al Thinker ESP32-CAM
Sparkfun LoRa Gateway 1-Channel

WiFi module

Foox family
Ardbox GPRS family

[®] Ardbox WIFI/BT family
M-Duino family

I (. Duino GPRS family I

Ardbox VAFUBT famiy on ¢



Once it is selected the Ardbox Family or Ardbox GPRS family an extra option will
appear on Tools:

- Select the correct Ardbox GPRS Board (Ardbox Relay HF+ w/HW RS-232 GPRS or
Ardbox Relay HF+ w/HW RS-485 GPRS) depending on your jumpers & switch
configuration.

© sketch_aug26a | Arduin 189
File Edit Sketch Toals Help

- _

Ctrl+Shifts]
Ctrl+Shift+M
Cirl+Shift+L

WIFi101 / WiFININA Firmware Updater

Board: “Ardbox WIFI/ET family" >
Madel, “Ardbox Analog HF+ wf HW RS-232 WiFi/BT* 3 (8] Ardbox Analog HF+ wi HW RS-232 WiFi/BT
t Ardbox Analog HF + w/ HW RS-485 WiFy/8T
‘Ardbox Relay HF+ w/ HW RS-232 WiFi/BT
| Ardbox Relay HF-+ w/ HW RS-485 WiFi/8T

Also there are some examples of programming in File -> Examples -> Ardbox Family.

Furthermore there are some extra libraries that can be found in Industrial Shields github.

https://github.com/IndustrialShields/

5. How to connect PLC Arduino to PC
- Connect USB port from PLC to PC.

NOTE:
Ardbox Family uses micro USB cable.

- Open Arduino IDE interface:
- Select Industrial Shields boards -> Ardbox Family

- Select correct port.


https://github.com/IndustrialShields/

D et maeta | Ardana 189 - 8 x
File Edit Skeich Tocls Help

Auto Format coteT
Axchive Skewch
Fix Encoding & Reload

Serial Monitor ColvShiftebd
Senial Poter Cot+shiftsl
WAF01 Firmware Updater
Boar “Archox Lamily
Inchrsrial Shields: “Arcibox Analog’
Port B seia pors
PUE Y GetBomd Infa COMI3 (Archana Leonardo]
Programmes: “Asing as ISP°
Bum Boatioader

Now everything is set up to upload a sketch to Ardbox Relay HF w/GPRS

6. How to connect PLC to power supply

- Ardbox Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT
REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

|::"."1.' ERSUPP LTl

— 1
Zm‘: | ucran |

|—f 24vee |

| |




- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm
DIN Rail:

-12Vdc / 24Vvdc

-2.5A

-30W

Industrial Shields power supplies provide parallel
operation, overvoltage protection, and overcurrent
protection. There is a LED inductor for power status,
the power supply is certified according to UL.

/@{

T

TRBY

Din RAIL Power Supply, ac-dc,
30W, 1 Output 1.3A at 24Vdc

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types

of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-

1.

WARINING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of

the equipment must be separated from the dangerous voltage cables.



7. Ardbox Relay HF I/0 Pinout:

7.1 Zone Connections
Base
(common unit)
LEFT ZONE
= sh|gh
8 aTr|laon
x 8 o o 5
o cm cm =1
S = 39139 S
Ts 29 | B9 5
<O <X (<X o
SO/RX_GPRS | GPRS |GPRS | MISO/RX_GPRS
SITX_GPRS | GPRS [GPRS | MOSITX_GPRS
SCK 15 15 SPI-CLOCK
RESET - - SPI-RESET
5vdC - - 5V Output
GND - - GND
RX-RS-232"° 0 8 Serial/lRS232
TX-RS-232"2 1 4 Serial/lRS232
RST_GPRS 2 2 RESET GPRS
PIN3 3 3 Ss
R1 10 10 Relay 1 Out
R2 9 9 Relay 2 Out
R3 6 6 Relay 3 Out
GND - - GND
24V - - -

HS*: Hardware Serial
SS*: Software Serial

1 See section 8 to enable these
2 See section 9 to enable these connections

NC

Half / Full
RS/ SCL
10.0/SDA
ON OFF
RE-RS485
10.4
DE-RS5485
10.5

[
2
2
)
=
%]

s5=021

LEFT ZONE

Switch config*

(see section 8 for Communications
configuration. Enabling Communications
disables some 1/0s)

Communications pins

Relay Outputs

Power supply connectors
(24vdc - GND)

connections



Base
(common unit) :I_
RIGHT ZONE RIGHT ZONE
* * —
= S0 | £En0
S |laz|ac =. |B- .
x © ow | owm 5 828y [A+ RS-485 pins
0l | cw |E® = P523 [z-/a01 ;
o = SY | 5% 3] < Analog Outputs Pins
T5 |30 |29 = Y+/200
< O X | <X [y
B- - - RS485 R4,.:
A+ - - RS485
¥ Relay Outputs
A0l | 11 ; RS485/Analog Output RS }I:
Y+/A0.0 13 - RS485/Analog Output
~Be—[ 109
R4 5 5 Relay 4 Out D 0.8
R5 3 3 Relay 5 Out FDe— | 107
FTe—| 106
10.9 23 23 Analog/Digital Input oDe—| 105"
s oD | 10.4" - .
10.8 22 22 Analog/Digital Input | 6o 103 Digital/Analog Inputs pins
10.7 21 21 Analog/Digital Input & poe—|[l02
nalog/Digital Inpu : o2
10.6 20 20 Analog/Digital Input £ o~e—li00"
1 | 19 | 19 | Analog/Digital Input 5 =
10.5 nalog/Digital Inpu 9 2 ,_
10.4* 18 18 Analog/Digital Input & 8 R64
5 S e
10.32 8 8 Digital Input g " 3
‘ E_. *
10.22 4 4 Digital Input E-é g gg R?C Relay Outputs
L. o = =
10.1 12 12 Digital Input E% zg §
10.0 2 2 Digital Input/ Interrupt % 3 3 c g RS,}I:
R6 7 7 Relay 6 Out H === L
R7: 0 0 Relay 7 Out
1 1 Relay 8 Out
Ra’ y

*Depending on the mode HD/FD the Y+/Z- analog outputs pins are enabled or disabled. See
section 9 to see the configurations

- |
= (DD P~
PIERE ~ o0 - 388333 . gt
= = = o H
0s0 O O[z0|[c=0 olo O] 0z Tk
g O He | S P N
0f0 O oo |lefo oo o | W L/
© + o . @ r~/jwo 0 v S RES
[=] o D/D o [=]

Config switch *
(see section 8 for communications
configuration)

Input / Output
LED

Power LED Arduino Reset button
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NOTE: Although in the TOP ZONE serigraphy it is shown Q0.9 & Q0.8 pins, in the reality they
are 10.3 10.2 pins respectively. Additionally although the serigraphy only is expressed for the
RS485 it is also the same for the R$232. So if it is desired to enable any of the Hardware Serial
connection this is the function of these switches. See chapter 8 for more information

<«——»|103 | RS485/RS232HS | 10.2 | RS485/RS232 HS

8. Switch configuration

8.1  General Switches Configuration

LEFT ZONE.
Communications and inputs/outputs cannot work simultaneously.

LEFT ZONE

SWITCH OFF ON

DE-RS485 A0.2-Q0.2* | DE-RS485

D10/A0.2-Q0.2 | DE-RS485 | A0.2-Q0.2

RE-RS485* | A0.1-Q0.1* | RE-RS485

D11/A0.1-Q0.1 | RE-RS485 | A0.1-Q0.1*

SDA-D2/10.0* SDA-D2 10.0

SCL-D3/Q0.6* | SCL-D3 Q0.6

*12C switch serigraphy is turned around. It should be: (SDA-D2 , SCL-D3). RX-RS485 should be RE-RS485

6. DE-RS485 — If this switch is ON, the A0.2-Q0.2 switch must be set to OFF. Being in ON mode
it enables DE for the RS-485.

5. A0.2-Q0.2 - If this switch is ON, the DE-RS485 switch must be set to OFF. Being in ON mode
it enables the outputs A0.2-Q0.2.

4. RE-RS485 — If this switch is ON, the A0.1-Q0.1 switch must be set to OFF. Being in ON mode
it enables EE for the RS-485.

3. A0.1-Q0.1 - If this switch is ON, the RE-RS485 switch must be set to OFF. Being in ON mode
it enables the outputs A0.1-Q0.1.

2. SDA-D2/10.0 — Choosing between SDA (12C) and 10.0. If this switch is ON, the 10.0 input will
be enabled and the SDA will be disabled. If this switch is OFF, the SDA will be now available
and 10.0 disabled




1. SCL-D3/Q0.6 — Choosing between SCL (12C) and QO.6. If this switch is ON, the Q0.6 input will
be enabled and the SCL will be disabled. If this switch is OFF, the SCL will be now available and

Q0.6 disabled.
TOP ZONE
SWITCH OFF ON
10.3 RS485/RS232 HS 10.3

RS485/RS232 HS

10.3

RS485/RS232 HS

10.2

RS485/RS232 HS

10.2

RS485/RS232 HS

10.2

RS485/RS232 HS

TOP ZONE

it

NOTE: Although in the TOP ZONE serigraphy it is shown Q0.9 & Q0.8 pins, in the reality they
are 10.3 10.2 pins respectively. Additionally although the serigraphy only is expressed for the
RS485 it is also the same for the RS232. So if it is desired to enable any of the Hardware Serial
connection this is the function of these switches. See chapter 8 for more information

<«—»|103 [ RS485/RS232 HS | 10.2 | RS485/RS232 HS

1. 10.3: If this switch is ON, the RS485/RS232 HS switch must be set to OFF. Being in ON
mode it enables 10.3.

2. RS485/RS232 HS: If this switch is ON, the 10.3 switch must be set to OFF. Being in ON
mode it enables the DO for the RS-485 or RS-232 Hardware Serial (see section 9 for
jumper configuration)

3. 10.2: If this switch is ON, the RS485 switch must be set to OFF. Being in ON mode it
enables 10.2.

4. RS485/RS232 HS: If this switch is ON, the 10.2 switch must be set to OFF. Being in ON
mode it enables the D1 for the RS485 or RS-232 Hardware Serial (see section 9 for
jumper configuration)




RIGHT ZONE
SWITCH OFF ON

H/F Full Duplex Half Duplex

Q0.6 ANALOG (A0.6) DIGITAL (Q0.6)
Q0.5 ANALOG (A0.5) DIGITAL (Q0.5)
Q0.4 ANALOG (A0.4) DIGITAL (Q0.4)
Q0.3 ANALOG (A0.3) DIGITAL (Q0.3)
Q0.2 ANALOG (A0.2) DIGITAL (Q0.2)
Q0.1 ANALOG (A0.1) DIGITAL (Q0.1)
Q0.0 ANALOG (A0.0) DIGITAL (Q0.0)

RIGHT ZONE. The right zone configures the outputs. If the switch is set to “ON” the Q0.X will
have the behaviour of a digital output. If it is set to “OFF” it will be analog. There is also a
switch for switching between Half and Full Duplex. It is “ON” for Half Duplex and “OFF” for Full

Duplex.
8.2 RS- 485 Switch configuration
TOP ZONE RS-485 TOP ZONE: In order to enable the RS-485 protocol the TOP ZONE
switch | MobE must be configured as it is shown in the table.
Although the switch serigraphy is only referenced to RS-485 it is also the
10.3 OFF
for the RS-232.
RS485 HS ON
102 OFF Having this setup, the 10.3 & 10.2 are disabled
RS485 HS ON
LEFT ZONE RS-485 LEFT ZONE: In order to enable the RS-485 communication

SWITCH CONFIGURATION

protocol it is necessary that the switches of the left zone are

SWITCH MODE | configured as it is showed in the table.
DE-RS485 ON

D10/A0.2-Q0.2 ore | The ones marked with “-“ mean that they don’t affect the RS-485
RE-RS485 oN communication protocol

D11/A0.1-Q0.1 OFF

SDA-D2/10.0

SCL-D3/Q0.6




8.3

RS-2

TOP ZONE

SWITCH | MODE | N

10.3 OFF

RS232 HS ON

10.2 OFF

RS232 HS ON

32 Switch configuration

RS-232 TOP ZONE: In order to enable the RS-232 communication protocol it is

ecessary that the switches of the top zone are configured as it is shown in

the table.

Although the nomenclature is not referenced to the RS-232, this switches
relates the hardware serial of the Arduino board.

RS-232 LEFT ZONE: In order to enable the RS-232 communication protocol

LEFT ZONE
swiTcH | mope| it is necessary that the switches of the left zone is configured as it is
DE-RS485 orr | showed in the table.
D10/A0.2-Q0.2 | ON
e e The ones marked with “-“ mean that it does not affect the RS-232

D1UA0L.Q0L| ON communication protocol
SDA-D2/10.0
SCL-D3/Q0.6

8.4  12C Switch configuration

TOP ZONE LEFT ZONE
SWITCH MODE SWITCH MODE
10.3 DE-RS485

RS485/RS232 HS

D10/A0.2-Q0.2

10.2

RE-RS485

RS485/RS232 HS

D11/A0.1-Q0.1

SDA-D2/10.0 OFF

SCL-D3/Q0.6 OFF

12C: Enable SCL and SDA connections (direct Arduino pins) with configuration switches. 10.0

and Q0.6 will not be available. In order to implement this communication a 4.7kQ pull-up

resistor (IS.ACI2C-4.7K) is required.


http://www.industrialshields.com/Industrial%20Pull%20UP%20I2C%20connection

9. Jumper Configuration

General Jumper Configuration

JUMPER ZONE 1

This jumper makes the choosing between connecting MAX232 to pins

0,1 of the Arduino Leonardo or with the MAX485. In order to use the
RS-232 Hardware Serial protocol both RS-232 must be connected to

the D1/DO. In order to use the RS-485 Hardware Serial protocol both

RS-485 must be connected to the D1/DO.

LEFT RIGHT
RS-485 RS-485
DO D1
RS-232 RS-232

JUMPER ZONE 2

This jumper zone makes the choosing between connecting the inputs

10.2, 10.3 to pins 4 and 8 of the Arduino Leonardo respectively, or

connect the RS-232 ports to activate the Software Serial RS-232. In
order to use the inputs 10.2,10.3 the jumper must be connected to the

pins 4 and 8. So 10.2 must be connected with D4 and 10.3 must be

LEFT RIGHT
10.2 10.3
D4 D8
RS-232 SS RS-232 SS

connected to D8.

*The jumpers that are not connected to the middle jumpers MUST NOT be Connected anywhere.

RS-485 RS-232
HARDWARE
SERIAL SERIAL 0.8

gt

b

L X
RS-232

SOFTWARE
SERIAL

( N 3
11 oo
Digital

HARDWARE Outputs



10. Hardware Serial RS-232 & RS-485 Configuration

10.1 Hardware Serial RS-485

In order to enable the Hardware Serial RS-485 the total configuration of the GPRS Ardbox
Relay HF will be:

Switch configuration:

LEFT ZONE
TOP ZONE SWITCH | MODE
SWITCH | MODE DE-RS485 ON
10.3 OFF D10/A0.2-Q0.2 | OFF
RS485 HS ON RE-RS485 ON
10.2 OFF D11/A0.1-Q0.1 | OFF
RS485 HS ON SDA-D2/10.0
SCL-D3/Q0.6
Jumper configuration:
TUMPER ZONE T JUMPER ZONE 2
LEFT RIGHT LEFT RIGHT

RS-485 RS-485 10.2 10.3
DO D1 D4 D8

Having configured GPRS Ardbox Relay HF as it is shown above, these are the features that are

available:

o Available communication protocols:
e Hardware Serial RS-485.
e 12C *If 12C is active 10.0 & Q0.6 are disabled

e SPI
o TTL
e USB

o Inputs: 8 out of 10 inputs, 10.0, 10.1 and 10.4 to 10.9. If using 12C 10.0 is also disabled
o Digital Outputs: All 10 outputs. If using 12C Q0.6 is disabled.
o Analog Outputs: From A0.0 to A0.6. If using I2C A0.6 is disabled



10.2 Hardware Serial RS-232

In order to enable the Hardware Serial RS-232 the total configuration of the Ardbox Relay HF
will be:

Switch configuration:

LEFT ZONE Note: The switches of the left
SWITCH MODE zone of the RS-485 don’t
TOP ZONE : ,
DE-RS485 OFF interfere in the RS-232 HS, the
SWITCH MODE L .
D10/A02-00.2 | ON thing is that as pins 0 & 1 are
10.3 OFF reserved for the RS-232, the
RE-RS485 OFF . . .
RS232 HS ON RS-485 is totally disabled. As it
10.2 OFF D11/A0.1-Q0.1 | ON is disabled, there is no point on
SDA-D2/10.0 - iouri i
RS232 HS oN configuring these switches as
SCL-D3/Q0.6 - RS-485 mode
Jumper configuration:
JUMPER ZONE 1 HALF DUPLEX JUMPER ZONE 2
LEFT RIGHT LEFT RIGHT
j j 10.2 10.3
DO D1 D4 D8
RS-232 RS-232 . ]

o Available communication protocols:
e Hardware Serial RS-232.
e |2C *If 12C is active 10.0 & Q0.6 are disabled

e SPI
e TTL
e USB

o Inputs: 8 out of 10 inputs, 10.0, 10.1 and 10.4 to 10.9. If using 12C 10.0 is also disabled
o Digital Outputs: All 10 outputs. If using 12C Q0.6 is disabled.
o Analog Outputs: From A0.0 to A0.6. If using 12C A0.6 is disabled



11. GPRS/GSM

The SIM800L module is the integrated module for the use of GPRS / GSM in this PLC and to
program it you must download this library on your Arduino IDE.

You can test the GPRS / GSM functionality using the examples that come with the library:

File Edit Sketch Tools Help

MNew Ctrl+N

Open... Ctrl+O

Open Recent >

Sketchbook >

Examples > A

Close Ctrl+W R ’

Save Ctrl+S =& ’

Save As..  Ctrl+Shift+S Servo ’
SpacebrewYun >

Page Setup  Cirl +Shift+P Stepper >

Print Crl+P Temboo >Hly:

Preferences Ctrl+Comma R ’
RETIRED >

Quit Cul+Q
Examples for M-Duino family
EEPROM >
Ethernet >
RS-232 >
RS-485 >
RTC >
SoftwareSerial >
SPI »
Wire >
Examples from Custom Libraries
Adafruit FONA Library 3 FOMNA3G_setbaud
Adafruit GFX Library FONA_SMS_Response
Adafruit RABBTS FOMAtest
DallasTem perature FOMAtest KEY mod
Ethernet2 GPS
HX711-master IncomingCall
OneWire »]

When defining the pins in the program, take into account that the internal connections
between the Sim800l module and the Arduino Mega are the following:


https://github.com/adafruit/Adafruit_FONA

Arduino Leonardo Pinout Sim800L Pinout

5Vdc Vce
GND GND
MISO TxD
MOSI RxD
Pin 2 GPRS RESET

The GPRS/GSM protocol is always enabled as there are no switches that configure it.

the GPRS / GSM protocol uses the SPI pins of the equipment to be able to communicate and
the pin2 for the module reset.

If you want to use the SPI pins, you must indicate in the program that pin2 is always in High
position. In case of using the SPI, the GPRS / GSM communication can not be used.

12. Ardbox - Arduino I/0s 5V pins

The Ardbox has some of the Leonardo board pins available. These pins can be programmed
according to Arduino features such as I/Os operating at 5V or any additional features present
in the pins (for example 12C communication in pins SCL and SDA). As this pins are directly
connected to the Arduino Leonardo board they are not as well protect as the normal inputs.
These pins are mainly meant to be used as prototyping.

M-Duino terminal Arduino pin
SCL-Pin3 3
MISO 14
SCK 15
MOSI 16

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5V.
These terminals provide direct access to the Leonardo board.

A part from the switch configuration there are some special conditions depending on these 5V.
Now it is going to be shown the considerations to operate with these pins.



111 [2C pins - SDA/SCL

The 12C protocol is meant to work in a pull-up configuration. The I2C pins in the Arduino
Leonardo are not pull-up, so in order to work with the 12C an external pull-up resistor is
required. If it is meant to work as a GPIO at 5V, the switches must be set as 12C, (section 8).

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.

121 11.2 Pin3

Pin3 is only referred to the input R5. If the switch configuration is in OFF position the pin Pin3
will be available.

This pin is not stablished with a pull-up or pull-down configuration. The state of pin 3 is
unknown. If using pin3, it requires a pull-up or a pull-down configuration. The Arduino board
allows pin 3 to be set in a pull-up configuration. If not it must be stablished an external pull-up
or pull-down circuit in order to correctly work with this pin.

12.2 11.3 SPI-MISO/MOSI/SCK

These pins are used for the GPRS module.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be established an external pull-up or pull-down circuit in order to correctly work with
these pins.

13. 1/0 technical details

Digital Output Waveform

[Tl o e——
v

DIGITALOUT




Digital Output Turn-off

DIGITAL OUT

PWM Waveform

PWM OUTPOLUT

——rem
ARDUIND PWHM OUT

]

AMNALOGOUT




Analog Out Turn-off

 ——

b 4

v

AMALDG OUT

Analog/Digital Input Turn-off
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14. Typical Connections

T

Ferrite KITA

@l ono 0 POWER
224¢ B oomam
SHIELDED CABLE E%

o-10V
SHIELDED CABLE
SH224V -omo— 0.7
GND
Ferrite KITA
a |GND 4 POWER
12724V B DIGITAL/ANALODG IN

SHIELDED CABLE ; Download e MOUSNO LAYOUT: \
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o-10v

—M 0.7

Ferrite KI{A
GND
@ ), 0) | | Power
224V /4 B DOTALANALOG W

SHIELDED CABLE %

SHIELDED CABLE

O "Qﬁ"j%&

ALWAYS
CONNECTED
Ferrite Kl
‘l‘“ B AR vou%?\-/wm
< 0wl I
SHIELDED CABLE \
e—
(.;;m
OUTPUT
* 580 the swilch
configutarion (ON)
Qlvde SM224v
COM (=) GND &
\J aLways
JUN CONNECTED
Ferrite KIT Qos ® SHIELDED CABLE
“1 VOUT = Q/ Ve
224V B DIGITALFWA OUT

SHIELDEDCABLET Qoies e AT LU a
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SHIELDED CABLE

Ferrite KIT#

GND
224V B—

SHIELDED CABLE

* Sse the switch
configutanon (ON)
e &
ALWAYS
J1n CONMECTED
Ferrte KITA ®
GND .
‘EI I. VOUT = O/ Vide
SHIELDED CABL \

)

./ y
SHIELDED CABLE

AN * See the switch

oa’ols_o configutarion (OFF)

GND |
T 0-10V
ADS5 |

SHIELDED CABLE

Ferrite KITA i o

) o)) power

224V E ANALOG OUT
SHIELDED CABLE Download the MOUINO LAYOUT:
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15. Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 THT — 1963502
from Phoenix contact. MCO0,5/10-G-2,5THT

For 1/0 and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact. FK-MC 0,5/10-ST-2,5

Connection details:

Article reference  MC 0,5/10-G-2,5 THT
Height 8,1mm
Pitch 2,5mm
Dimension 22,5mm
Pin dimensions 0,8x0,8mm
Pin spacing 2,50mm
Article reference FK-MC 0,5/10-ST-2,5
Rigid conduit section min. 0,14 mm?
Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?
Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20



https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1963502&library=usen&tab=1
https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1881406&library=usen&tab=1#General
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16. ARDBOX Family Dimensions:

101

129
114

< =

45mm width

17. DIN rail mounting:

Rev. 0: 30-08-2019

Profilato o cappello TH 35-7,5 Prcfilato o cappello TH 35-15
Top hat rail TH 35-7,5 Top hat rail TH 35-15
.
e B
755
1004
15°
% RO8
R12
=03 k03
3 |
ISR 1004
v Sezione A/ Section A R12
0.3 mox & 2,2 min. fino 0/ To 2,5 max
?i —
= Sezione A/ Section A
CARATTERISTICHE METODO  UNIA'  BLEND FEATURES TEST UNITS  BLEND
DI MISURA _PU/ABS METHOD PUABS
Mecconiche R iong ol KTAD638  MPo 68 Mechanical fest R ik yield ASTMDS38 MRy 68
i o060 Ot ISTMDE38  MPo L] Tonslestrongth ASTADS38 MRy L]
Al KT0638 % 59 Ulimonts ok ASTMDE8 % 59
doboin KSUADTN0  MPg 289 Haing modules ASTMDTS0 MRy 8%
Provo I20d con intogl 150180714 Xy 55 rod st motched S0180/14  Xifm" 55
Termiche Temp. di mmmolimento Viot metdo B ASTMDISZS _°C 114 Thermal fest Vit sodtei atod B ASTMDIS2S  C 14
Tompetotm Riatio 1 81 MRy KD °C 9 Rebeating tomperctus 181 MPa ASTHDS4  °C 9
Fisiche Peso peci KD gdamd 12 Physical test  Specific ity ASTMDT92 _ g/and 1.1
Riti nello st KUADISS % 0406 d shrink ASTMD9SS % 0406
Mk Flow ndex 260°C - 98N KSTHDIZE /10 1 Ml Fow Index 260°C - 98N ASTADIZS  gi10° 1l
(Comportamento Aukesinguerza (mm di pesor) s - V-0(08) Flome fest ol etinguisher (idness in mm) (I3 - V(08
allo fiomma Fib Inondescen 32 mm 69521 °C 960 Ingond thveod 32 mm IEC69521  °C 960

Italtronic si riserva il dititto di modificare il moteriole con cui realizza i propri prodotti
senzu obbligo di preawiiso.

Italtronic con operate ony change of the moteriols without being obliged to forewamn.
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18. Revision Table

Revision Date Changes
Number

0 30/08/2019 It was first implemented




About Industrial Shields:

Address: Fabrica del Pont, 1-11

Zip/Postal Code: 08272

City: Sant Fruitds de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611

Mail: industrialshields@industrialshields.com
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